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Software (Firmware) Agreement 

This product contains embedded software (firmware), the use of 

which is governed by the following agreement.  By unpacking the 

unit and switching it on you indicate your acceptance of the 

conditions.  If you do not accept the conditions of this agreement, 

please return your unit, with all packaging, to the place of purchase. 

By unpacking and switching on the unit you agree not to decompile, 

disassemble, dump, reverse engineer or create derivative works of 

the embedded software contained in the unit.  You also agree not to 

allow a third party to do any of these things on your behalf. 

 

FCC Compliance Statement 

This device complies with Part 15 of the FCC Rules. Operation is 

subject to the following two conditions: 

1. this device may not cause harmful interference, and 

2. this device must accept any interference received, including 

interference that may cause undesired operation.  
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1 Introduction 

1.1 What’s an Octavius Squeezer? 

Congratulations! You have the world’s coolest synth pedal for bass 

guitar. 

Octavius Squeezer is an analog synthesizer pedal for electric bass 

guitars.  It contains the analog filter circuit that we’ve been refining 

for years in our Agent 00Funk series of envelope filter pedals.  It also 

contains the analog fuzz circuit from our Brown Dog gated bass fuzz 

pedal. 

But Octavius Squeezer is a lot more than just a filter and a fuzz – it 

can track the notes you play and synthesize new waveforms.  It can 

sweep and step the filter in all kinds of new exciting ways. It has state 

of the art reconfigurable analog circuitry which allows you to change 

the order of the effects circuits and mix and patch signals in a variety 

of ways. 

As you’d expect from such a pedal, Octavius Squeezer has true 

bypass switching, connecting the input directly to the output by a 

mechanical switch when it is bypassed.  When it’s off it’s really off! 

All this analog grunt is controlled by a digital control system which 

makes it easy to get the same sound every time.  Octavius Squeezer’s 

flexible firmware lets you manage up to 50 effects at once, program 

the functions of the footswitches, sort effects into banks for easy 

selection and even swap effects with your friends by saving and 

loading them from SD card.  You can also download new versions of 

the firmware from our website and use your SD card to update 

Octavius Squeezer as new features become available. 
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1.2 Analog? But it Looks Digital! 

Looking at it, you might think Octavius Squeezer is a purely digital 

piece of equipment.  It’s got a liquid crystal display with text written 

on it and a slot for a digital SD card, for example. 

However, under the hood the signal processing is analog and there’s 

a good reason for that.  The characteristics of resonant filters and 

analog fuzz circuits are extremely complex, especially when you drive 

them hard.  These are notoriously difficult to model nicely using 

digital signal processing techniques.  Also, digital resonant filters 

have a variety of stability and linearity issues associated with them. 

And, let’s face it, analog is just cooler. 

1.3 About this Document 

This manual is the main source of information on the Octavius 

Squeezer. 

Chunk Systems is a small manufacturer that builds in low volume. We 

would likely have to print this document in high quantities and 

stockpile them for months to do it economically.  This would severely 

restrict our ability to provide you with the latest information.  We’ve 

therefore chosen to provide this document in electronic form only, 

so that you can always download the most recent version from our 

website at www.chunksystems.com. 

Throughout this document, bold type is used for the names of 

controls, menu items and other text that you’ll see printed on the 

Octavius Squeezer enclosure or on the display.  Italic type is used 

where terms are being introduced. 

http://www.chunksystems.com/
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2 Getting Started 

2.1 Introduction 

In this chapter, we’ll discuss the basic operation of your pedal.  Start 

here to learn how to plug in, power up and start using your Octavius 

Squeezer. 

2.2 Software (Firmware) Agreement 

Before continuing, ensure you have read and understood the terms 

of the software agreement at the start of this manual.  Unpacking 

and powering up the unit indicates your acceptance of the 

agreement. 

2.3 Register 

Please visit our website at www.chunksystems.com and register your 

details with us for warranty purposes.  Registration gives you full 

access to all the available downloads and support information for the 

Octavius Squeezer. 

2.4 Installing a battery 

The first thing you’ll need is a way to power your Octavius Squeezer.  

You can use either a standard 9V battery or an external 9VDC supply. 

To install a battery, unscrew the battery drawer thumbscrew on the 

front panel of the unit and slide out the battery drawer.  Attach the 

battery clip securely to the battery terminals and push the end of the 

battery with the clip attached right to the back of the drawer.  You 

can now push down on the other end of the battery to fit it down 

into the battery drawer - it’s a snug fit to stop the battery rattling 

around.  Once the battery is installed in the drawer, slide the drawer 

closed and tighten the thumbscrew to secure it. 

http://www.chunksystems.com/
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2.5 Connecting a Power Supply 

If you’re going to use your Octavius Squeezer a lot, and let’s face it, 

you probably will, we recommend you get yourself an external power 

supply.  The power supply must be 9VDC with a 2.1mm tip-negative 

plug – the kind used for most  effect pedals.  Your power supply must 

be capable of delivering up to 300 mA to the Octavius Squeezer.  

Chunk Systems recommends using a well regulated supply such as 

the Godlyke Powerall, available from Godlyke Inc. 

(www.godlyke.com). 

2.6 Switching the Power On 

When you connect an external power supply, Octavius Squeezer 

turns on immediately.  If running from battery, Octavius Squeezer 

does not switch on until a plug is inserted into the in socket.  To save 

battery power, unplug your input lead when you’re not using your 

Octavius Squeezer. 

2.7 Connecting your Leads 

Connect a lead from your instrument to Octavius Squeezer’s in 

socket.  Connect another lead from the out socket to the input of 

your amplifier.  Leave the aux socket unconnected for the moment. 

2.8 Switching on an Effect 

Octavius Squeezer should now be powered on and ready to use.  

Push and release the right footswitch to take it out of bypass mode 

so you can hear an effect.  The active LED glows to indicate that the 

effect is on.  Play some notes on your instrument to hear the effect.  

To turn the effect off and go back to your instrument’s standard 

sound, push and release the right footswitch again.  The active LED 

turns off to indicate that Octavius Squeezer is bypassed.  When 

bypassed, the out socket is connected directly to the in socket with a 

mechanical switch. 

2.9 Using the Effects Screen 

The main screen which Octavius Squeezer displays is called the 

Effects Screen.  Turn the effect knob clockwise to move up through 

the available effects.  Turn it anticlockwise to move down through 

the effects. 

Each effect has parameters that change how it sounds.  Turn the 

param knob to change the currently-selected parameter.  To choose 

which parameter is selected, push the param knob.  You can push it 

once to move forward by one parameter, hold it down to cycle 

through them or turn it while holding it down to manually scroll 

through them. 

To enter the menu system, push the effect knob. 
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2.10 Using the Menus 

Once in the menu system, turn the effect knob to scroll through the 

items on the current menu.  Push the effect knob to enter a 

submenu or execute a command. 

Menu parameters show their current value on the bottom line after 

an equals sign (=). Turn the param knob to change the value of a 

parameter. 

To exit a submenu, scroll all the way to the last item, which is always 

labelled Back.  With Back selected, push the effect knob to exit the 

submenu.  The last item on the main menu is labelled Exit menu.  

Push the effect knob with Exit menu selected to return to the effects 

screen. 

2.11 Set Power Mode 

Octavius Squeezer has a sophisticated power management system 

which lets you trade off battery life against sound quality.  If you 

want your battery to last as long as possible, it’s a good idea to set 

the Power setting to medium or low.  Do it like this: 

 Push and release the effect knob to enter the menu system.   

 Find the Settings menu and click the effect knob to enter it. 

 Find the Power parameter on the Settings menu. 

 Change the Power setting to med or low using the param 

knob. 

 Back out of the Settings menu. 

 Use Exit menu to return to the effects screen. 

2.12 Optimise for Your Instrument 

Different bass guitars can produce vastly different volume levels.  

Some adjustment is therefore necessary to get the best results with 

your Octavius Squeezer. 

You’ll probably find you need to adjust the Track sens. parameter on 

the Settings menu to get the best pitch-tracking performance with 

your instrument.  You’ll almost certainly need to turn it down if you 

play an active bass with a hot output. 

The VCF sens. parameter, also on the Settings menu provides a 

global sensitivity adjustment for all the effects that use an envelope 

follower, so that you don’t need to change the parameters of all your 

effects when you plug in a new instrument.  You’ll also want to turn 

this down if you play a hot active bass. 
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3 Menus 

3.1 Introduction 

The effects screen, covered in chapter 4, gives you control over the 

effects system.  However, to access all of Octavius Squeezer’s other 

features, you need to understand how to use the menu system.  It’s 

pretty easy really, but we’ll cover it in detail in this chapter. 

3.2 Menus and Menu Items 

Octavius Squeezer has an hierarchical system of menus. Each menu 

contains a list of menu items. Each menu item is one of the following 

types: 

 Parameter – Used for settings which are numbers or where 

you can choose one of several options. 

 Command – Allows you to perform an action, such as saving 

changes to an effect (see Figure 3-1). 

 Text – Used for entering and editing names, such as effect 

names and file names. 

 Browse – Lists the existing files on the SD card. 

 Submenu – Another level of related menu items. 

3.3 Entering the Menu System 

To enter Octavius Squeezer’s menu system from the main effect 

screen, push the effect knob on the right. The first item on the main 

menu will be displayed. 

3.4 The Menu Display 

While the menu system is active, Octavius Squeezer displays the 

name of the currently-selected item on the top line of its display, 

surrounded by square brackets [] as shown in Figure 3-1. To the left 

Figure 3-1: A command menu 
item. 
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and right of the brackets are scroll arrows, which tell you whether it’s 

possible to scroll forwards or backwards from the current menu 

item. The left scroll arrow disappears when the first item on a menu 

is selected because it’s not possible to scroll backwards from the first 

item. Similarly, the right scroll arrow disappears when the last item 

on a menu is selected because you can’t scroll forwards from the last 

item. 

On the bottom line of its display, Octavius Squeezer shows 

information about the currently-selected menu item. For parameter 

menu items, an equals sign (=) is displayed, followed by the current 

value of the parameter (see Figure 3-2). For other menu items, the 

type of the item is shown (see Figure 3-1 and Figure 3-3). 

3.5 Navigating the Menus  

Scroll through the items on the menu by turning the effect knob. To 

change the value of a parameter, turn the param knob. To enter a 

submenu (see Figure 3-3), execute a command, or edit text, push the 

effect knob. For more information about editing text, see section 

4.11 on page 22. 

To exit a submenu and return to the main menu, scroll all the way to 

the last item on the menu by turning the effect knob clockwise. The 

last item on each submenu is labelled Back (see Figure 3-4). Push the 

effect knob while Back is selected to return to the main menu. 

The last item on the main menu is Exit Menu (see Figure 3-5). To exit 

the main menu and return to the effect screen, scroll all the way to 

the end of the main menu and push the effect knob while Exit Menu 

is selected. 

3.6 Menu Reference 

This section describes all of the items found in each of the menus on 

Octavius Squeezer’s main menu along with a reference to the section 

and page on which you can find further information about it. 

The Exit Menu item (see Figure 3-5) is the last item on the main 

menu. Use it to exit the menu system and return to the effect screen. 

3.6.1 Effect menu 

The Effect menu contains parameters and commands that affect the 

effect library.  The items on the Effect menu are: 

 Effect name – Edit the name of the current effect. Section 

4.11, page 22. 

 Copy – Mark the current effect for copying to another 

location in the library. Section 4.9, page 21. 

Figure 3-3: A submenu menu 
item. 

Figure 3-4: The Back command. 

Figure 3-5: The Exit Menu 
command. 

Figure 3-2: A parameter menu 
item. 
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 Paste – Paste an effect into the current location in the 

library. This item will only be available if you have previously 

marked an effect with the Copy command. Section 4.9, page 

21. 

 Delete – Delete the current effect, marking the location as 

empty in the library. Section 4.10, page 22. 

 Save changes – Save any changes you have made to the 

current effect to the effect library.  This command will only 

be available if you’ve modified the current effect.  Section 

4.8, page 21. 

 Undo changes – Undo any changes you have made to the 

current effect by reloading it from the effect library. This 

command will only be available if you’ve modified the 

current effect.  Section 4.8, page 21. 

 Save all – Save to the library all the changes you’ve made to 

all the effects. This command will only be available if you’ve 

modified one or more effects.  Section 4.8, page 21. 

 Undo all – Undo all changes to all effects by reloading them 

from the library. This will only be available if you’ve modified 

one or more effects.  Section 4.8, page 21. 

 Param mode – Choose the parameter editing mode.  Use 

edit (default) mode to change the value of effect parameters 

or show mode to choose which parameters are displayed for 

the current effect.  Section 4.7, page 20. 

 All params – Enable this option to display all parameters on 

all effects regardless of the parameter’s display status.  

Section 4.7, page 20. 

 Randomize – Set all the parameters of the current effect to 

random values.  Section 4.12, page 23. 

 Back – Return to the main menu. 

3.6.2 Bank menu 

The Bank menu allows you to select and modify banks. The items on 

the Bank menu are: 

 Active bank – Select which bank is currently active.  Section 

5.2 page 24. 

 Edit bank – Add, remove and reorder effects in the current 

bank.  Section 5.3, page 25. 

 Save changes – Save any changes you’ve made the current 

bank. This command will only become available if you’ve 

used the Edit bank command.  Section 5.4, page 26. 

 Undo changes – Undo any unsaved changes you’ve made to 

the current bank using the Edit bank command.  Section 5.4, 

page 26. 
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 Back – Return to the main menu. 

3.6.3 Rhythm menu 

The Rhythm menu allows you to control Octavius Squeezer’s rhythm 

machine. The items on the Rhythm menu are: 

 Tap – Tap a tempo for the rhythm machine by clicking the 

right knob instead of switching to TAP footswitch mode.  

Section 7.4, page 32. 

 Stop – Stop the rhythm machine.  Section 7.4, page 32. 

 BPM – Adjust the tempo (in beats per minute) of the rhythm 

machine.  Section 7.4, page 32. 

 Beats in bar – Adjust the time signiture of the rhythm by 

selecting the number of quarter notes (crotchets) per bar.  

Section 7.4, page 32. 

 Bars in loop – Adjusts the number of bars the rhythm 

machine plays before returning to the start of the loop and 

resetting the beat-locked effects.  Section 7.4, page 32. 

 Tap averages – Adjust the minimum number of taps that are 

used to determine the tempo in tap tempo mode.  Section 

7.4, page 32. 

 Click out – Control whether a click track is mixed into the 

main output when the rhythm machine is running.  Section 

7.4, page 32. 

 Click sound – Choose which of the inbuilt sounds is used for 

the click track.  Section 7.4, page 32. 

 One level – Adjust the volume level of the click played on the 

One (the first beat of each bar).  Section 7.4, page 32. 

 Click level – Adjust the volume level of the click played on 

any beat of the bar other than the One.  Section 7.4, page 32. 

 Click decay – Adjusts the decay speed of the click 

synthesizer.  Section 7.4, page 32. 

 Back – Return to the main menu. 

3.6.4 Footswitch menu 

The Footswitch menu controls the behaviour of Octavius Squeezer’s 

footswitches. The items on the Footswitch menu are: 

 Mode – Change the current footswitch mode.  Section 6.3, 

page 27. 

 Scheme – Change the current footswitch scheme.  Section 

6.4, page 28. 

 Custm scheme – Program in a custom footswitch scheme 

containing a custom sequence of footswitch modes.  Section 

6.5, page 29. 
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 Latency – Adjusts the latency between pushing a footswitch 

and the Octavius Squeezer’s response.  Section 6.6, page 29. 

 Back – Return to the main menu. 

3.6.5 Settings menu 

Global settings that don’t belong on any of the other menus can be 

found on the Settings menu.  These are: 

 Track sens. – Adjust the sensitivity of the pitch tracking 

system for the level of your instrument.  Section 2.12, page 

12. 

 VCF sens. – Adjust the global sensitivity of envelope follower 

effects for the level of your instrument.  Section 11.9.15, 

page 53. 

 Power – Choose how much power to use, trading off battery 

life against noise performance.  Section 10.4, page 44. 

 Bklight time – Choose how long the display backlight stays 

on for.  Section 10.4, page 44. 

 LCD contrast – Adjust the contrast of the display.  Section 

10.5, page 44. 

 Swap knobs – Swap the function of the effect and param 

knobs, which is useful for left-handed players.  Section 10.6, 

page 45. 

 Aux mode – Choose the function of the aux connector.  

Section 10.3, page 43. 

 Tuner effect – Choose which effect is heard when the tuner 

is engaged.  Section 8.3, page 35. 

 Allow reset – Enable the Reset all command.  Section 10.7, 

page 45. 

 Reset all – Return all settings to factory defaults, delete all 

effects, empty all banks.  Section 10.7, page 45. 

 Back – Return to the main menu. 
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4 Effects 

4.1 Introduction 

This chapter covers the meat of Octavius Squeezer operation, how to 

turn the effects on and off, switch between them, edit their 

parameters and how the main effects screen works. 

4.2 The Effects Library 

Octavius Squeezer stores a library of up to fifty effect definitions in 

its onboard flash memory. These effect locations are numbered 00 to 

49.  Each effect has a name and a set of effect parameters that may 

be adjusted using the param knob.  Details on all the parameters and 

how to use them can be found in section 10. 

To help you organise this library and make it easy to quickly select 

the right effect when playing live, effects can be assigned into user-

defined banks.  You can program the order of the effects in a bank so 

it’s easy to switch to the next effect you need with the left 

footswitch.  See section 5 starting on page 24 for more information 

about banks. 

4.3 The Effects Screen 

The main screen which Octavius Squeezer displays is called the 

effects screen, and is shown in Figure 4-1. The top line of the display 

gives information about which effect is currently loaded. The bottom 

line of the display operates in one of two modes: status line mode, 

or parameter mode. 

At the top left of the effects screen you’ll see the two digit location 

of the current effect within the effect library. The first location in the 

library is numbered 00, and the last location is numbered 49. 

Figure 4-1: The effects screen. 
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To the right of the effect number is the change indicator. When an 

effect has been modified from its original definition in the library, a 

right double angle bracket (») is shown (see Figure 4-2). If you 

haven’t modified an effect from its original definition in the library, a 

colon (:) is shown (see Figure 4-3). This provides an easy way to tell 

whether you’ve modified the current effect.  

The remainder of the top line is used to display the name of the 

current effect.  If the name of the effect is too long to fit here, it 

automatically scrolls to display all the characters in the name after a 

short time. So, if you can’t read all the name of the current effect, 

just wait, and Octavius Squeezer will scroll it for you. 

Anytime you switch effects or change an effect parameter, the 

bottom line of the effects screen automatically switches to 

parameter mode.  In parameter mode, the abbreviated name of the 

currently selected parameter is shown on the left and the current 

value of that parameter is shown on the right (refer to Figure 4-3). 

If you don’t switch effects or change effect parameters for a few 

seconds, the bottom line will switch to status line mode.  The status 

line displays current information about the current footswitch mode, 

the tempo and beat position of the rhythm machine, and the pitch of 

the note you are currently playing. 

In the following sections we’ll cover the contents of the status line 

and the parameter display in further detail. 

4.4 The Status Line 

The status line is displayed automatically on the bottom line of the 

effects screen a few seconds after your last interaction with the 

knobs. That is, it’s like a screen saver and you’ll see if you don’t 

switch effects or modify parameters for a few seconds. 

The leftmost part of the status line is the current footswitch mode 

(TAP in Figure 4-4). See section 6.3 on page 27 for more information 

about footswitch modes. 

To the right of the footswitch mode is the current tempo of the 

rhythm machine.  To the right of the tempo is the current sequence 

time.  The example in Figure 4-4 has the tempo set at 120 bpm and 

the rhythm machine is currently playing the first beat of the first bar. 

If the rhythm machine is currently stopped, ---- is displayed as shown 

in Figure 4-5. 

The rightmost part of the status line shows the current pitch tracking 

status, which you can use as a kind of “mini-tuner”.  In the example 

of Figure 4-4, a G is being played and it is tuned flat, as indicated by 

Figure 4-2: A modified effect. 

Figure 4-3: Parameter mode. 

Figure 4-4: The status line. 

Figure 4-5: Blank time, blank 
note. 
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the down arrow.  If no note is currently detected, -- is displayed, as 

shown in Figure 4-5. 

4.5 Selecting Effects 

Turn the effect knob to move up and down through the effects in the 

library.  If a bank is currently active (through the Active bank setting 

on the Bank menu), turning the effect knob selects only between 

effects in the active bank, rather than all the effects in the library.  

See section 5.2 on page 24 for more information on selecting banks. 

You can also move up and down through the effects using the 

footswitches. See section 6 for more information. 

4.6 Effect Parameters 

The name of the current parameter appears on the left hand side of 

the lower line of the effects screen whenever the status line is not 

shown, as seen in Figure 4-3.  There are several ways to select a 

parameter of the current effect for editing: 

1. Click the param knob to move to the next parameter. 

Moving forward from the last parameter wraps back to the 

first parameter. 

2. Push and hold the param knob to cycle through the 

parameters. 

3. Push and turn the param knob to move backwards and 

forwards through the available parameters. 

Once you have chosen the parameter you want to edit, turn the 

param knob to increase or decrease its value.  Some parameters 

have values which are displayed as numbers (as in Figure 4-2), 

whereas other parameters allow you to choose between a list of 

choices with 4 letter names (as in Figure 4-3). 

For more specific information about each parameter and how to use 

it, refer to section 10. 

4.7 Hiding and showing parameters 

An Octavius Squeezer effect has 47 parameters which can be varied 

to change it’s sound.  For many types of effect, however, it only 

makes sense to vary a handful of these in a live setting. For this 

reason, the definition of an effect includes a hide/show switch for 

each parameter. This means that, when designing a new effect, you 

can choose which parameters you want the Octavius Squeezer to 

display for that particular effect, although the parameters always 

appear in a pre-defined order. 

To change which parameters are displayed for an effect, change the 

Param mode item on the Effect menu to show and exit the menu 
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system.  Now you can cycle through all the parameters with the 

param knob as usual, but turning the param knob changes whether 

the current parameter is hidden or shown, as seen in Figure 4-6, 

instead of changing its value.  Once you’ve finished hiding and 

showing parameters, set Param mode back to edit for normal 

parameter editing behaviour. 

Sometimes when creating new effects it’s useful to be able to ignore 

the hide/show status of each parameter and simply show them all.  

To do this, set the All params item on the Effect menu to on.  This 

temporary setting applies to all effects, not just the current effect.  It 

will be reset when you turn off the power. 

4.8 Saving and Undoing Effect Changes 

When you modify the parameters of an effect, you are making a 

temporary modification for the current performance only – you’re 

just tweaking the effect on-the-fly to suit a particular song, for 

example.  These temporary changes will be lost if you power off the 

unit.  Also, there is only room in Octavius Squeezer’s RAM for four 

effects concurrently, which means, in effect, that you can only hold 

three modified effects at once while browsing the library. If you 

modify a fourth effect, your modifications to the first effect will be 

lost when you switch to a fifth effect. 

If you make a modification to an effect that you want to keep 

permanently, you use the Save changes item on the Effect menu to 

save your modified effect definition to the library.  Conversely, you 

can undo any changes to an effect and return to original version in 

the library by using the Undo changes item on the Effect menu.  

If you’ve modified an effect and you want to save your changes but 

also keep the original effect, you can copy the modified version and 

paste it into a new library location, then Save changes on the new 

location.  See section 4.9 for information on copying and pasting.. 

Save changes and Undo changes operate on the currently-selected 

effect only.  To save or undo changes to all the effects in RAM, you 

can use the Save all and Undo all commands on the Effect menu. 

One of the effect parameters is called protect.  If an effect has its 

protect parameter set to on, you can’t save changes to that effect 

without first setting protect to off. 

4.9 Copying and Pasting Effects 

Octavius Squeezer provides a simple way to copy effects between 

library locations.  You can even copy a version of an effect you 

Figure 4-6: Parameter display 
status 
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modified but not yet saved, allowing you to save it in a different 

location to the original effect. 

To copy the current effect, even if it has been modified, choose Copy 

from the Effect menu.  Exit the menu and select the location in the 

library you want to copy the effect to.  Choose Paste from the Effect 

menu to paste the copied effect as the current effect.  To 

permanently save this in the current library location, choose Save 

changes from the Effect menu or, if you made a mistake, choose 

Undo changes. 

4.10 Deleting Effects 

Use the Delete command on the Effect menu to delete the contents 

of the current effect location, marking it empty.  As with other effect 

changes, the Delete command is temporary and should be followed 

with the Save changes command to make the deletion permanent. 

4.11 Editing Effect Names 

Octavius Squeezer effects each have a name which is up to 24 

characters long.  You can edit the name of an effect using Octavius 

Squeezer’s knobs.  There are numbers, uppercase letters, lowercase 

letters, Japanese characters, European accented and umlauted 

characters, punctuation symbols and a variety of mathematical 

symbols that can be entered into effect names. 

To enter the name editor, shown in Figure 4-7, choose Effect name 

from the Effect menu.  A flashing cursor shows which character in 

the name is currently selected for editing.  Use the knobs to edit the 

name like this: 

 To move the cursor backwards and forwards in the name, 

turn the effect knob. 

 To change the character under the cursor, turn the param 

knob. 

 Click the param knob to enter the current character and 

move to the next character.  You must click the param knob 

to add extra parameters at the end of a name since you can’t 

move forwards from the last character. 

 Click the effect knob to exit the name editor. 

At the right end of the lower line of the name editor, you’ll find the 

position counter which tells you which of the 24 character positions 

the cursor is over (position 6 in Figure 4-8).  This makes it easy to tell 

how much of your 24 character quota you’ve used.  

The current editing mode is shown at the left end of the lower line of 

the name editor.  Normally, the editing mode is set to Write, which 

Figure 4-7: The name editor in 
Write mode. 

Figure 4-8: The name editor in 
Insert mode. 
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behaves as described above.  To use other editing modes, keep 

turning the param knob anticlockwise past the space character.  

Figure 4-8 shows the name editor with the Insert mode selected.  

The editing modes are: 

 Write – click the param knob to enter the current character 

and move to the next character. 

 Insert – click the param knob to insert a space before the 

current cursor position. 

 Delete – click the param knob to delete the current 

character. 

 Back – click the param knob to delete the previous character. 

 Trim – click the param knob to delete the current character 

and all following characters. 

Just like editing the parameters of an effect, editing an effect name is 

a temporary change.  You must use the Save changes command to 

make the change permanent as described in section 4.8 on page 21. 

4.12 Effect Randomizer 

Octavius Squeezer features a handy tool to assist in inventing new 

effects – the effect randomizer.  Choosing Randomize from the 

Effect menu simply sets all of the parameters of the current effect to 

random values.  As always, you’ll need to Save changes if you want 

to keep the new random values permanently. 

The randomizer does not have any intelligence or attempt to choose 

“good-sounding” parameter values, it just chooses them at random, 

so you might need to try it several times before you get a good 

result.  You’ll normally have to manually edit the effect afterwards to 

fine-tune it, but the randomizer can be a useful starting point for 

coming up with effects that you might not otherwise have thought 

of.   
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5 Banks 

5.1 Introduction 

Effects in Octavius Squeezer’s library can be organised into banks, to 

make them easier to select.  You can put all the effects you’ll need 

for a particular song, set or entire performance into a bank ahead of 

time in the order you’ll need them and then easily move to the next 

effect using the footswitches.  Alternatively, you might just use the 

banks to sort effects in the library into different categories. 

Octavius Squeezer has eight banks and each bank can hold up to 

sixteen effects.  You work with banks using the Bank menu.  Banks of 

effects can also be saved and loaded from the SD card so you can 

work with more than eight banks, transfer entire banks between 

Octavius Squeezer pedals or even send your favourite bank of effects 

to a friend by email. 

5.2 Banks and the Effects Library 

A bank does not store effects itself, rather it is simply a list of up to 

sixteen effect numbers, like an index into the library.  Therefore, if 

you modify one of the effects in the library, that change will affect 

any bank which references that effect number. 

Choose which bank is currently active using the Active bank item on 

the Bank menu.  When one of the banks is active, turning the effect 

knob in the main effects screen changes to the next or previous 

effect in the bank, rather than the next or previous effect in the 

whole library.  So, if you want to browse through all the effects in the 

library, set Active bank to none. 
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5.3 Modifying Banks 

You can modify which effects are in a particular bank and the order 

in which those effects appear by first selecting the bank to edit using 

Active bank and then invoking the Edit bank command, also on the 

Bank menu. 

The bank editor lists the numbers of the effects in the banks across 

the screen as shown in Figure 5-1.  A flashing cursor shows which 

effect number is currently selected for editing.  Left and right arrows 

show whether it is possible to move the cursor left and right from it’s 

current location.  The left arrow will disappear if the cursor is at the 

first location and the right arrow will disappear is the cursor is at the 

last location.  The name of the effect at the cursor position is shown 

on the lower line of the display. 

Use the bank editor like this: 

 Move forwards or backwards through the effects in the bank 

by turning the effect knob. 

 Change the effect under the cursor by turning the param 

knob. 

 Click the param knob to enter the current effect and move 

the cursor to the next location. 

 Click the effect knob to exit the editor. 

Like the effect name editor discussed in section 4.11, the bank editor 

has some more advanced editing functions too.  When you have one 

of the advanced editing functions selected, the display looks like 

Figure 5-2, with the function name at the lower left and the position 

in the bank at the lower right.  Turn the param knob clockwise past 

effect number 49 to select the advanced editing functions.  The 

advanced editing functions are: 

 Insert – Click the param knob to insert a space for new effect 

before the cursor.  The new space is initially set to effect 00, 

but you can go and change it to whichever effect you like 

after the Insert operation.  If the bank is already full, you will 

lose the last effect from the bank. 

 Delete – Click the param knob to delete the current effect 

from the bank.  

 Swap Left – Click the param knob to swap the order of the 

current effect and the previous effect.  The cursor moves 

with the current effect which makes it easy to move the 

current effect several places backwards in the bank by 

clicking the param knob multiple times.  Performing a Swap 

Figure 5-1: The bank editor. 

Figure 5-2: The bank editor in 
Insert mode. 
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Left on the first effect in the bank swaps the first effect to 

the end of the bank. 

 Swap Right – Similar to the Swap Left function, click the 

param knob to swap the order of the current effect and the 

next effect.  Performing a Swap Right on the last effect 

swaps it with the first effect. 

5.4 Saving and Undoing Bank Changes 

As with effect modifications, modifications to banks are temporary 

and will be lost if you switch banks or power off the unit.  To 

permanently save changes you have made to a bank, choose Save 

changes from the Bank menu.  This menu option will only be 

available if you have actually made some changes. 

You can also choose Undo changes from the Bank menu if you want 

to undo changes you’ve made to the active bank and reload the 

original version. 
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6 Footswitches 

6.1 Introduction 

Octavius Squeezer’s two footswitches can be set up to behave in a 

variety of ways.  Some of the things you can do with the footswitches 

include: 

 Toggling the current effect on and off. 

 Switching between effects. 

 Activating muted tuning mode. 

 Tapping a tempo for the rhythm machine. 

 Starting and stopping the rhythm machine. 

 Modifying the sound of the current effect. 

This chapter covers the operation of the footswitches in detail. 

6.2 Basic Operation 

In almost all of the footswitch modes, the right footswitch is used to 

toggle the current effect on and off.  The active LED indicates 

whether the current effect is currently switched on, or whether 

Octavius Squeezer is in true bypass mode, with its input mechanically 

connected directly to its output. 

The function of the left footswitch depends on the current mode as 

described in the next section 6.3. 

6.3 Footswitch Modes 

You can set up Octavius Squeezer’s footswtiches to operate in one of 

several modes, depending on what makes most sense for your 

performance style.  As described in more detail in section 4.4 on 
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page 19, the current footswitch mode is indicated by a three letter 

code at the left hand end of the status line. 

The footswitch modes are: 

 NXT – Push the left footswitch to move to the next effect in 

the library or bank.  Hold it down to cycle forwards through 

the effects. 

 PRV – Push the left footswitch to move to the next previous 

effect in the library or bank. Hold it down to cycle backwards 

through the effects. 

 TAP – Tap the left footswitch once to start the rhythm 

machine running.  Tap it multiple times to enter a tempo.  

Hold it down for about one second to stop the rhythm 

machine. 

 MOD – Push and hold the left footswitch to modify the 

sound of the current effect (normally by switching on the 

LFO) if the effect supports it. 

 TUN – Push and hold the left footswitch to enter muted 

tuning mode.  A full-screen tuning display is shown and the 

output is muted. 

 U/D – Up/down mode. Push the left footswitch to advance 

forwards through the effects in the bank or library.  Push the 

right footswitch to go backwards.  Push both footswitches at 

once to toggle the effect on or off. 

There are two ways to change the current footswitch mode: 

 By hand, using the Mode parameter on the Footswitch 

menu. 

 By foot, using a footswitch scheme, as described in more 

detail in the next section.  In any footswitch mode apart from 

U/D mode, you can push both footswitches at once to move 

to the next mode in the current scheme. 

6.4 Footswitch Schemes 

Octavius Squeezer provides a way for you to configure which 

footswitch modes are available when you switch modes with your 

feet, and what order the modes appear in.  This ordered list of 

modes is known as the current footswitch scheme. 

In addition to a custom (custm) scheme which you can program 

yourself, as described in the next section, Octavius Squeezer has 

some handy pre-programmed schemes: 

 foot scheme – Includes all the modes that you might want to 

switch between in a live setting: NXT, PRV, TAP, MOD, TUN. 
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 safe scheme – Includes only the tuning (TUN) mode.  Use this 

scheme if you only ever want to use the left footswitch to 

activate the tuner and you want to make sure you can’t 

accidentally switch to another mode during a live 

performance. 

 u/d scheme – Includes only the up/down (U/D) mode. Use 

this scheme if you only ever want to use the footswitches in 

up/down mode.   

To set the current footswitch scheme, use the Scheme parameter on 

the Footswitch menu. 

6.5 Custom Footswitch Schemes 

If you want full control over the footswitch modes to switch between 

in a live setting, you can program your own footswitch scheme of up 

to eight modes. 

Select the custm option for the Scheme parameter on the 

Footswitch menu activate the custom scheme.  Also on the 

Footswitch menu, you’ll find a Custm Scheme submenu, which 

contains a set of parameters labelled Mode 1, Mode 2 … Mode 8.  

Edit these parameters to choose which footswitch mode is used in 

each slot of the scheme.  The scheme will start with the footswitch 

mode listed under the Mode 1 parameter.   Pushing both 

footswitches will switch to the mode listed under the Mode 2 

parameter and so forth.  Once you have added all the modes you 

want to your custom scheme, select the END option for the 

remaining Mode parameters.  This tells Octavius Squeezer to wrap 

back to the first mode. 

Footswitch scheme information is stored as part of Octavius 

Squeezer’s global configuration.  It is automatically saved when you 

exit the menu system so your setup will be remembered when you 

switch the power off. 

6.6 Footswitch Latency 

Octavius Squeezer needs to be able to detect when you push both 

footswitches at the same time, because this is how you switch 

between the modes in a footswitch scheme and how you toggle the 

effect on and off in U/D mode.  However, it’s impossible for a human 

being, even one as talented as yourself, to push two switches at 

exactly the same instant, especially in a live setting when you’re 

concentrating on other stuff, such as playing your instrument.  When 

you push a footswitch, therefore, Octavius Squeezer waits for a very 

short time before taking any action, to see whether the other 
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footswitch gets pushed as well.  This short wait time is called the 

footswitch latency. 

If you’re the kind of player who switches modes infrequently in a live 

setting, you’d probably prefer to have a short latency so that 

Octavius Squeezer responds more quickly when you push a single 

footswitch.  On the other hand, if you’re a tap-dancer who enjoys 

constantly switching footswitch modes on the fly, you’d prefer to 

make Octavius Squeezer less sensitive to timing differences when 

you push both footswitches so that you can switch modes reliably. 

To accommodate both kinds of players, Octavius Squeezer allows you 

to tune the latency to your taste using the Latency parameter on the 

Footswitch menu, which operates in 512ths of a second between 1 

and 128. 
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7 Rhythms 

7.1 Introduction 

Octavius Squeezer provides a rhythm machine for stepping and 

sweeping the onboard filter in time with the beat.  This chapter 

covers starting, stopping and setting the tempo of the beat. 

Octavius Squeezer’s rhythm machine can also provide a click 

track/metronome for use in a practice setting.  You can also send a 

click track out of the aux output for use in a live setting.  You might 

connect this to your drummer’s foldback or headphones for example 

so that your band syncs to Octavius Squeezer’s beat-locked effects. 

There is also a flexible tap tempo mode to allow you to manually 

slave Octavius Squeezer to an external tempo in a live setting. 

7.2 Beat Status 

The current tempo is displayed on the status line. If the rhythm 

machine is running, the tempo LED blinks in time with the beat and 

the status line indicates the rhythm machine time to the bar and 

beat.  Refer to section 4.4 on page 19 for more information on the 

status line. 

7.3 Using Beat-Locked Effects 

Octavius Squeezer’s effects can be set to sweep or step the filter in 

various ways in time with the beat.  If you are using an effect with 

beat-locking enabled, you will need to ensure the rhythm machine is 

running in order to hear any beat-locked effect. 

Refer to section 10 for information on creating beat-locked effects. 
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7.4 Rhythm Settings 

As well as the TAP footswitch mode, you can use the items on the 

Rhythm menu to control the rhythm machine: 

 The Tap command allows you to start the rhythm machine, 

tap a tempo or resynchronise using the right knob without 

switching to TAP footswitch mode. Executing the Tap 

command has an identical effect to tapping the left 

footswitch in TAP mode, except that you can’t hold down the 

knob to stop the rhythm machine.  A separate Stop 

command is provided for this.  Refer to the following 

sections 7.5, 7.6 and 7.7 for more information on tapping, 

starting and resynchronising. 

 The BPM parameter is used to directly enter an exact tempo 

in beats per minute. 

 Beats in bar sets the time signature of the rhythm machine 

by setting the number of quarter notes (crotchets) in each 

bar. 

 Bars in loop sets the number of bars in a repeating loop of 

music or ostinato.  When using beat-locked effects, Octavius 

Squeezer resets the sweep each time the start of the loop 

comes around.  Effects can also be set to sweep the filter 

slowly, repeating over the entire loop, rather than a bar or a 

beat. 

 Tap averages sets the minimum number of taps (between 2 

and 8) used to calculate a new tempo.  Refer to section 7.6. 

 Click out determines whether a click (metronome) sound is 

postmixed into Octavius Squeezer’s output when the rhythm 

machine is running.  You can set this to off, and set Aux 

mode to clik on the Settings menu to produce an 

independent click track at the aux output. 

 Click sound selects which of the built in sounds is used for 

the click.  The options are named as they sound: bip (low 

sine), pip (high sine), pong (low square), ping (high square) 

and zip (swept sawtooth). 

 One level and Click level are used to set how loud the click 

sounds are.  One level adjusts the level of the click “on the 

one”, the first beat of each bar.   Click level adjusts the level 

for all other beats of the bar.  Typically you set One level a 

little higher than Click level to emphasise the start of the bar. 

 Click decay is a number between 0 and 15 used to determine 

the decay time of the click sound.  Set it to a high number for 

long, loud tones and to a small number for short, sharp 

clicks. 
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7.5 Starting and Stopping the Beat 

To control the rhythm machine with your feet, switch to the TAP 

footswitch mode (see section 6.3 on page 27).  In this mode the left 

footswitch is used to control the rhythm machine. Tap it once to start 

the beat at the current tempo.  You can pre-program the tempo 

using the BPM parameter on the Rhythm menu, or you may have 

previously tapped a tempo in and then stopped the rhythm machine. 

To stop the beat, hold the left footswitch down for about a second. 

7.6 Tapping a Tempo 

To tap a tempo using the TAP footswitch mode, simply tap the left 

footswitch in time with the beat. The minimum number of taps used 

to calculate the tempo you are tapping is set by the Tap averages 

parameter on the Rhythm menu.  Each extra tap makes Octavius 

Squeezer’s tempo more accurate and it will use up to eight of the 

most recent taps. 

7.7 Resynchronising 

Even if you tap a tempo very accurately, you may still find that after 

several bars it starts to get out of time with an external beat.  To deal 

with this issue, simply tap the left footswitch once on a beat.  

Octavius Squeezer responds by playing it’s next beat exactly one beat 

after your tap.   

You should wait a few seconds after tapping a tempo before 

attempting to resynchronise so that Octavius Squeezer can tell 

you’re not trying to tap a new (slower) tempo.  
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8 Tuner 

8.1 Introduction 

No, not the fishy kind. Octavius Squeezer contains a built-in tuner to 

help you tune the strings of your bass guitar quickly and accurately.  

There’s no point in lugging a separate tuning device to your gig when 

Octavius Squeezer already has an advanced pitch-tracking system! 

8.2 Muted Tuning Mode 

To enter full-screen muted tuning mode, switch to TUN footswitch 

mode.  You can do this using the Mode parameter on the Footswitch 

menu or you can push both footswitches at once until TUN is 

displayed on the left end of the status line. See section 6.3 on page 

27 for full details of changing footswitch modes. 

One in TUN footswitch mode, push and hold the left footswitch to 

engage muted tuning mode.  Octavius Squeezer exits tuning mode 

and returns to normal as soon as you release the left footswitch.  

Play the note on your instrument that you want to tune and the 

tuning screen displays the note being played on the upper line. 

A series of arrows on the lower line indicate whether tuning is 

currently sharp or flat.  Arrows pointing to the right indicate that the 

tuning is currently flat as shown in Figure 8-1 and that the tension on 

that string needs to be increased.  Arrows pointing to the left as 

shown in Figure 8-2 indicate that the tuning is currently sharp and 

that tension on the string needs to be relaxed.  More arrows indicate 

that more correction is required. 

When tuning is correct for the current note, one left arrow and one 

right arrow are displayed as shown in Figure 8-3. 

Figure 8-1: Tuning mode - A# 
tuned flat. 

Figure 8-2: Tuning mode - A# 
tuned sharp. 

Figure 8-3: Tuning mode - A# in 
tune. 
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8.3 Tuner Effect 

While tuning mode is engaged, Octavius Squeezer switches to an 

effect in your library, effect 49 by default.  Typically you would leave 

this effect set up so that no sound is produced while you are tuning.  

However, you are free to customise the tuning effect for your own 

purposes.  You can choose which effect is used during tuning by 

setting the Tuner effect parameter on the Settings menu. 

8.4 Quick Tuning Display 

Basic tuning information is also available on the status line in the 

main effects screen as shown in Figure 8-4 and detailed in section 4.4 

on page 19.  This display can be useful for “quick and dirty” tuning 

without switching footswitch modes and without muting the output.  

The quick tuning display only indicates whether the current note is 

sharp or flat, and does not give you an indication of how much you 

need to correct by. 

Figure 8-4: Status line with quick 
tuning display at lower right. 
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9 Files 

9.1 Introduction 

Octavius Squeezer has an SD/MMC card slot on the front panel.  This 

lets you save and load effects and banks for extra storage and 

transfer effects to and from your computer if it has an SD card 

reader.  Inexpensive SD card readers that connect to your PC or Mac 

by USB are readily available from computer stores.  

Octavius Squeezer’s firmware can also be updated using the SD card 

as new versions are released.  Chunk Systems will be providing 

firmware update files on the website at www.chunksystems.com, 

which you can download, save to your SD card and load onto your 

Octavius Squeezer. 

Downloadable effects libraries and forums to exchange your new 

effects with others are also planned for our website. 

9.2 Supported Cards 

Octavius Squeezer is designed to work with SD (Secure Digital) cards 

and MMCs (Multi-Media Cards) which are commonly used in digital 

cameras and other portable media equipment.  No card is included 

with the unit, but you can easily purchase an SD card and a reader 

for you PC or Mac at a computer or camera store.  You might even 

find that your digital camera already has an SD card and the camera 

itself can operate as a reader when connected to your computer by 

USB. 

Octavius Squeezer is designed to operate with cards up to 4GB in 

capacity bearing the SD or MMC logos and formatted using the 

FAT16 or FAT32 file system.  You may find that other variants such as 

http://www.chunksystems.com/
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Transflash/MiniSD also work with the appropriate adapter if they 

support the optional SPI mode of operation.  SDHC (Secure Digital 

High Capacity) cards, which are 4GB and above are not currently 

supported. 

You do not need a lot of space for storing Octavius Squeezer effects 

on an SD card; A 1GB SD card can store more than 10 million 

Octavius Squeezer effects!  Therefore, any old low capacity card is 

fine.  

9.3 File types 

Octavius Squeezer saves and loads effects from a proprietary file 

format with the extension OFX.  An OFX file can store any number of 

effects and may be used to store effects from a bank or directly from 

the library.  Only files that are stored in the root directory of the card 

and that have a standard DOS 8.3 character filename can be accessed 

by Octavius Squeezer. 

OSF files containing firmware updates for the Octavius Squeezer can 

also be read from the card as described in section 9.9.  Only one OSF 

file may be present on the card at any one time. 

9.4 Inserting and Removing a Card 

To load a card into the Octavius Squeezer, insert it into the slot on 

the front panel with the label facing upwards and the diagonal corner 

cutout on the right-hand leading edge.  Push it in until it engages 

with a faint click – there should only be approximately 1.5mm of card 

protruding from the slot when correctly engaged. 

To remove a card, push it in to disengage the spring-loaded eject 

mechanism.  Do not attempt to simply pull a loaded card from the 

socket as this will damage your unit. 

Octavius Squeezer is designed to sit on the floor and be stepped on 

but SD cards and readers are not. If you accidentally step on a 

protruding SD card you will very likely damage the card and the 

pedal.  Therefore, when the card is not in use, we recommend that 

you completely remove it from the slot.  Octavius Squeezer also 

requires more battery power and takes longer to start up if a card is 

loaded. 

9.5 Saving Effects 

To save effects from the effects library, you select the first effect you 

want to save in the main effects screen.  Next, set the Effect limit 

parameter on the File menu to the number of effects to save.  For 

example, to save effect numbers 10 to 29 to the card, you would 

select effect 10 and set the Effect limit to 20. 
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If the Effect limit is greater than the remaining higher-numbered 

effects in the library, then Octavius Squeezer wraps back to the first 

effect after the end of the library is encountered during the saving 

process.  For example, if you select effect 40 and set the Effect limit 

to 20, effect numbers 40-49 and then 00-09 will be saved to the file. 

To save the entire library, select effect 00 and leave the Effect limit 

at its default value of 50. 

Once you have specified which effects to save, the next step is to tell 

Octavius Squeezer the name of a file to save them to.  Use the File to 

save item on the File menu for this.  Click the effect knob with this 

menu item selected to enter a file name editing screen which 

operates identically to the effect name editor described in section 

4.11 on page 22. 

Only the main part of the filename can be edited using the File to 

save editor, which is shown in Figure 3-1. The file extension is 

assumed to be .OFX.  If you do not change File to save from its 

default value, your effects will be saved to a file named OS.OFX. 

By default, Octavius Squeezer will not overwrite the file if one with 

the chosen name already exists.  If you do want Octavius Squeezer to 

overwrite an existing file with new effect data, switch on the 

Overwrite parameter on the File menu. 

Now that you have given Octavius Squeezer all the information it 

needs to save your effects, choose the Save effects command on the 

File menu.  Any modifications you have made to effects will first be 

saved to the library and then the selected effects will be saved from 

the library to the file.  The saving process can take up to a minute 

and Octavius Squeezer displays an ellipsis (…) at the lower left of the 

screen to show that it is working. 

While we don’t expect you’ll encounter any errors using the file 

access functions, Octavius Squeezer does not have extensive error 

checking of file operations (we preferred to use the limited available 

resources to ensure it sounds killer) and may not always report if 

there is an error saving your effects to the file.  Therefore, if you’re 

saving mission critical effect data, you should probably load the card 

into your computer afterwards and check that everything has gone 

according to plan. 

9.6 Saving Banks 

The procedure for saving a bank of effects is very similar to that for 

saving effects directly from the library, so ensure you’ve read section 

9.5 in detail first. 

Figure 9-1: File to save 

Figure 9-2: Save in progress. 
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Select the bank you want to save using the Active bank parameter on 

the Bank menu.  Octavius Squeezer will save effects starting from the 

first effect in the bank (the current effect selection is ignored).  The 

Effect limit can be used to control which effects from the bank are 

saved if set to number less than 16 (the maximum number of effects 

in a bank). 

Once you’ve selected the right bank, and checked that Effect limit, 

File to save and Overwrite are set to the right values, execute the 

Save Bank command. 

9.7 Loading Effects 

To load effects from an OFX file to the effect library, start by 

selecting, in the main effects screen, the first effect number in the 

library that you want to load into.  You’ll also want to set Effect limit 

on the File menu if you want to limit the number of effects to be 

loaded.  If you want to load all the effects from an OFX file to the 

library, just leave Effect limit at the default value of 50. 

Next you need to choose which file to load using the File to load 

parameter on the File menu.  With this parameter selected, use the 

param knob to browse backwards and forwards through the OFX 

files on the card.  Only OFX files are listed and the file extension .OFX 

is not shown, as seen in Figure 9-3. 

Now you can execute the Load effects command on the File menu to 

begin the loading process.  Octavius Squeezer loads the first effect 

from the OFX file and attempts to save it to the currently selected 

effect location in the library.  If that location has its protect 

parameter set to on, it will move to the next location in the library 

and try again.  If the end of the effects library is reached and no 

unprotected location has been found, Octavius Squeezer wraps back 

to the start of the effect library and continues searching for 

unprotected locations at effect 00.  Once the first unprotected effect 

location is found, Octavius Squeezer overwrites that effect in the 

library with the new effect from the OFX file.  Octavius Squeezer then 

reads the next effect from the OFX file and the process repeats.  The 

load operation continues until one of the following occurs: 

1. All the effects have been loaded from the OFX file. 

2. The number of effects loaded reaches the Effect limit. 

3. There are no remaining unprotected locations in the effect 

library. 

Let’s look at an example.  If you select effect 20 and set the Effect 

limit to 10, Octavius Squeezer will load the first ten effects in the OFX 

file into effect locations 20-29 as long as none of the existing effects 

Figure 9-3: Choosing a file to 
load. 
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in those locations are protected and as long as there are ten or more 

effects in the OFX file.  If effect 25 were protected, Octavius Squeezer 

would load into locations 20-24 and then 26 to 30, leaving protected 

effect 25 intact. 

Here’s another example.  You select effect 40 and leave the Effect 

limit set at the default value of 50.  Effects 00-19 have their protect 

parameters set to on and the remainder of the effect locations in the 

library are unprotected.  You load an OFX file containing twenty 

effects.  The first ten effects in the file will be loaded to locations 40-

49.  Octavius Squeezer then tries to load the remaining ten effects 

starting at location 00 and discovered that effects 00-19 are 

protected.  The remaining ten effects from the file therefore will be 

loaded to locations 20-29. 

9.8 Loading Banks 

To load effects from an OFX file into one of the banks, start by 

selecting the target bank using the Active bank parameter on the 

Bank menu.  You can also set the Effect limit parameter on the File 

menu if you want to load only the first few effects in the file. 

Next, choose your OFX file using the File to load item on the File 

menu, as discussed in section 9.7 on loading effects. 

Now you’re ready to execute the Load bank command on the File 

menu.  Octavius Squeezer loads 16 effects from the file, unless the 

file contains fewer effects than that or the Effect limit is lower than 

16.  The effects from the file are loaded into locations in the effect 

library determined by Octavius Squeezer, and those effect locations 

are then written to the bank so that the effects in the bank appear in 

the same order as in the file. 

Since a bank is just an index into the effect library (see section 5.2 on 

page 24), Octavius Squeezer must choose locations in the effect 

library into which to load bank effects.  Here’s how it chooses: 

1. Octavius Squeezer first searches for an existing identical 

effect in the library.  If an identical effect is found, a second 

copy is not loaded.  The location of the existing effect is 

written to the bank instead. 

2. If the effect does not already exist in the library, Octavius 

Squeezer searches for the first empty location to load it into.  

You can free up locations prior to loading a bank using the 

Delete command on the Effect menu. 

3. If no empty locations can be found, Octavius Squeezer 

searches for the first unprotected effect location and 

overwrites that effect with the effect from the file. 
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4. If all locations are in use and all are protected, the load 

operation is aborted. 

Let’s look at an example.  You have set up bank 1 of your Octavius 

Squeezer to contain effects 20, 21, 24 and 28 and you want to copy 

this bank of effects to bank 2.  You use the Save bank command to 

save bank 1 to an OFX file called Bank1.OFX, which contains the four 

effects in order.  Next you select bank 2 as the Active bank and use 

Load bank to load Bank1.OFX.  Octavius Squeezer finds that the four 

effects in the file are already loaded at locations 20, 21, 24 and 28 so 

it does not load a second copy of them, it just sets bank 2 to contain 

effects 20, 21, 24 and 28. 

Let’s take the example a bit further.  Now you want to email your 

bank 1 to a friend so she can load it to bank 1 on her Octavius 

Squeezer.  You load your SD card into your computer’s SD card 

reader and attach Bank1.OFX to an email.  Your friend saves 

Bank1.OFX to her SD card and loads it into her Octavius Squeezer.  

She selects bank 1 using Active Bank and then uses Load bank to 

load Bank1.OFX.  It just so happens that she already has a copy of 

your effect 21 stored in her effect library at location 30 (you sent it to 

her earlier) and locations 40-49 in her effect library are empty.  Her 

Octavius Squeezer therefore loads your effects 20, 24 and 28 to 

locations 40, 41 and 42 in her library and sets her bank 1 to contain 

effects 40, 30, 41, 42 in order.  Your friend can now use bank 1 

exactly as you do, even though the effects involved are at differently 

locations in her effects library than in yours. 

9.9 Updating the Firmware 

When you update firmware on your Octavius Squeezer, all your 

effects and banks will be lost and will return to the default factory 

settings.  You therefore need to save any effects and banks you want 

to keep to your SD card as described earlier in this chapter before 

you start the update procedure.  You should also make note of any 

menu settings you’ve made as these will also be returned to their 

factory settings. 

If you are running your Octavius Squeezer from battery, make sure 

your battery is not flat before attempting to upgrade firmware.  If 

your battery runs out halfway through the update procedure your 

firmware will be left in an unusable state and won’t be able to use 

your Octavius Squeezer until you can successfully complete the 

update procedure. 

Octavius Squeezer’s firmware is updated by loading an OSF file from 

the SD card.  Check the Chunk Systems website at 

www.chunksystems.com for the latest OSF (Octavius Squeezer Figure 9-4: Firmware update 
confirmation. 

http://www.chunksystems.com/
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Firmware) file, load your SD card into your computer’s SD card 

reader and save the OSF file to the card.  You must ensure that only 

one OSF file is present on the card at any one time or the firmware 

upgrade procedure will not work as intended, so you should delete 

any older OSF files from the card when you download a new one. 

Once you have your OSF file on your SD card, switch off your 

Octavius Squeezer by removing the plug from the in socket and 

disconnecting any external DC power supply.  Load the SD card into 

the slot with the power switched off and then switch Octavius 

Squeezer on by connecting an external DC power supply or 

connecting a plug to the in socket.  Reading card… is displayed as 

Octavius Squeezer analyses the OSF file and, if the file is valid, you 

are asked to confirm the update, as shown in Figure 9-4.  Push the 

param encoder to choose yes and confirm the firmware update, or 

push the effect encoder to choose no and abort the firmware update 

and start the Octavius Squeezer normally. Note that the Swap knobs 

option described in section 10.6 on page 45 does not affect this 

confirmation screen. 

While the firmware update is in progress, updating .. is shown on the 

screen.  Once complete, Octavius Squeezer starts the new firmware.  

You can confirm which version of firmware is running by looking at 

the boot screen, shown in Figure 9-5, which appears for a second 

while Octavius Squeezer starts up.  The unit’s hard-coded serial 

number is also shown here. 

9.10 Reloading the Firmware 

If, for any reason, the main firmware of your Octavius Squeezer 

becomes corrupted, the cannot boot message is displayed when you 

turn on the power, as shown in Figure 9-6.  This is usually the result 

of a power failure during a previous attempt to update firmware. 

To recover from this scenario, you need to reload the main firmware 

from an OSF file.  Start by obtaining the most recent OSF file from 

the Chunk Systems website and saving it onto your SD card as 

described in section 9.9 above.  Now, with the SD card inserted, 

switch the unit on by plugging in an external DC supply or connecting 

a lead to the in socket.  After briefly displaying the reading card … 

message, Octavius Squeezer prompts you to start the firmware 

reload, as shown in Figure 9-7.  Push the param knob to start the 

reload, during which updating .. will be displayed.  When complete, 

Octavius Squeezer starts normally. 

Figure 9-5: Boot screen showing 
firmware version (top right) and 
serial number (bottom right). 

Figure 9-6: cannot boot message, 
indicating firmware corruption. 

Figure 9-7: Firmware reload 
confirmation prompt. 
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10 Settings 

10.1 Introduction 

Many of Octavius Squeezer’s menus contain configuration settings 

which affect how the pedal operates and many of these are covered 

in detail elsewhere in this manual.  In this chapter, we’ll cover 

everything about settings that’s not documented in other chapters. 

10.2 Storage of Settings 

Most settings found on Octavius Squeezer’s menus are “sticky”.  That 

is, Octavius Squeezer remembers them even when you switch the 

power off and back on.  It does this by writing them into its internal 

flash memory whenever you exit the menu system.  To ensure that 

your settings are remembered, always exit the menu system before 

turning off the power. 

10.3 Aux mode 

The Aux mode parameter on the Settings menu controls the function 

of the aux socket.  The options are: 

 off – aux socket is disabled. 

 env – aux socket produces a lo-fi copy of the input signal.  

You can plug this into the env input of a Chunk Systems 

Agent 00Funk Mark II. 

 clik – aux socket produces a line-level click track 

(metronome).  Note that you can’t drive headphones directly 

from this. 
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10.4 Power 

If you plan on running Octavius Squeezer from a battery, you’ll want 

that battery to last as long as possible.  Therefore, Octavius Squeezer 

provides settings to customise how much power it uses. 

The Power parameter on the Settings menu allows you to trade off 

power consumption against sound quality.  If you want the lowest 

possible noise for studio use, set it to high.  If sound quality is not 

your primary concern, set it to med to make your battery last a little 

longer.  If you really need to make the battery last a long time and 

you don’t care about sound quality – in a practice situation, for 

example – you can set the Power parameter to low or even vlow 

(very low).  Octavius Squeezer’s battery will last over twice as long in 

vlow mode as in high mode. 

Another major consumer of power is the backlight for Octavius 

Squeezer’s display.  You can maximise your battery life by minimising 

the amount of time the backlight is on. The backlight automatically 

switches on when you play a note, push a footswitch, turn or push 

one of the knobs.  The Bklight time parameter on the Settings menu 

allows you to customize the amount of time, in seconds, it stays on. 

You can turn Bklight time all the way down below 1 second to the off 

setting to disable the backlight completely.  This is a useful power 

saver during the day or under strong lighting.  You can also turn the 

control up past the maximum value of 60 seconds to the on setting if 

you’re operating at night from an external DC supply and you want 

the backlight to stay on permanently. 

The SD card also draws power from the battery when inserted, so 

remove the SD card when you’re not using it. 

Lastly, Octavius Squeezer remains switched on whenever a lead is 

connected to the in socket.  If you take a break from playing for a 

while, consider disconnecting the input lead to prolong the life of 

your battery. 

10.5 Display Contrast 

Use LCD Contrast on the Settings menu to adjust the contrast of the 

display to your taste.  It’s just a number between 0 and 15.  A high 

setting may be easier to read but the display may appear more 

blurred and consume more power.  You should adjust it so that you 

can clearly read the text but so that the inactive background pixels 

are invisible. 
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10.6 Swap Knobs 

Left handed? If so, you might find that you obscure the display with 

your hand when you use the effect knob to switch effects.  Turn on 

the Swap knobs parameter on the Settings menu to completely swap 

the functions of the knobs.  This does not affect the LEDs or the 

footswitches. 

10.7 Reset All 

The Reset all command on the Settings menu can be used to return 

all settings to their factory defaults, empty all banks and delete all 

effects from the library, regardless of their protect parameter.  

Obviously, this is a pretty serious thing to do and you don’t want to 

accidentally delete your data.  The Reset all command is therefore 

unavailable unless you set the Allow reset parameter, also on the 

Settings menu, to on. 
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11 Modifying Effects 

11.1 Introduction 

This chapter describes Octavius Squeezer’s flexible signal processing 

architecture and how to use effect parameters to control it. 

We’ll start by giving an overview of the signal processing system, 

then we’ll cover the practical use of some aspects of the system in 

more detail.  The remainder of the chapter is devoted to an 

exhaustive description of each effect parameter. 

11.2 Signal Flow Overview 

The block diagram of Figure 11-1 shows the signal processing 

architecture of the Octavius Squeezer. 

The input signal enters through the high impedance input buffer (1), 

through the tracking amplifier (2) and into the digital pitch tracking 

subsystem (3).  The Track sens. parameter on the Settings menu is 

used to adjust the gain of the tracking amplifier (2) to suit the level of 

your instrument. 

The Voltage Controlled Oscillator (VCO, 6) synthesizes a tone 

transposed up or down in relation to the input signal, normally by an 

octave up or down (4).  The Voltage Controlled Amplifier (VCA, 7) 

applies an amplitude envelope to the synthesized waveform.  If the 

synth premix mute switch (9) is open, the synthesized waveform is 

sent to the filter premixer (10) where it is mixed with the signal from 

the premix gain (22) and premix selector (23).  The premixer output 

is then sent to the Voltage Controlled Filter (VCF, 11). 
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The Voltage Controlled Filter (VCF, 11) has a bandpass output and a 

lowpass output, one of which is selected by the output selector (17) 

and amplified or attenuated by the output gain (18) before arriving 

at the filter postmixer (19).  The postmixer mixes the filter output 

with the postmix signal, chosen by the postmix selector (26) and 

amplified or attenuated by the postmix gain (27).  The click track 

output is also mixed in here if the Click out parameter on the 

Rhythm menu is set to on. 

The postmix output runs through the output buffer (20) and then to 

the out socket, unless the pedal is in bypass mode.  In that case the 

out socket is instead directly connected to the in socket by a 

mechanical switch (21). 

11.3 The Fuzz 

The fuzz circuit (30) takes its input from a signal chosen by the fuzz 

selector (24).  The fuzz gain (25) determines how hard the fuzz circuit 

is driven.  The output of the fuzz circuit can be used either as the 

premix signal, postmix signal or both through the premix selector 

(23) and postmix selector (26). 

11.4 Synthesizing Tones 

To synthesize a tone, start by using the input mode parameter to 

select a waveform, then set VCO pitch to choose the pitch of the 

synthesized tone relative to the input note.  In square wave mode, 

you can also set VCO duty to change the duty cycle of the wave.  

VCO->VCF should be set to on unless you want to send the 

synthesized tone through the fuzz circuit only, by setting fuzz source 

to syn. 

Figure 11-2: ADSR envelope 
showing attack time (AT), decay 
time (DT), sustain time (ST), 
release time (RT), attack level 
(AL), sustain level (SL) 

Figure 11-1: Signal flow architecture. 
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You’ll also need to set up the VCA.  In env mode, the VCA tracks the 

amplitude of the input note.  If, on the other hand, the VCA mode is 

set to ADSR, the VCA follows a generated envelope with attack, 

decay, sustain and release phases as shown in Figure 11-2.  

When a note is detected at the input in ADSR mode, the envelope 

generator attacks from silence up to the attack level (AL), set by the 

VCA att lvl parameter.  The time it takes for this to happen, the 

attack time (AT) is determined by the VCA att spd parameter.  Next 

the envelope generator decays away to the sustain level (SL), set by 

the VCA sus lvl parameter.  The decay time (DT) is determined by the 

VCA dec spd parameter.  Once the decay phase is complete, the 

envelope generator holds at the sustain level until the input note 

stops, so the sustain time (ST) is not set by any parameter, but by 

how long you hold the note for.  When the note stops the envelope 

generator releases back to silence, taking the release time (RT) to get 

there.  The release time is determined by the VCA rel spd parameter.  

If, however, the VCO stop parameter is set to on, the VCO is abruptly 

halted when the input note stops, so no release phase is heard. 

11.5 Filtering 

Octavius Squeezer’s Voltage Controlled Filter (VCF) is a two pole 

(12dB/octave) resonant filter with lowpass and bandpass outputs.  

The cutoff frequency of the filter is set by an input voltage.  Roughly 

speaking, only frequencies above the cutoff frequency will be heard 

at the lowpass output, and only frequencies very close to the cutoff 

frequency will be heard at the bandpass output.  In layman’s terms, 

this makes the lowpass output sound bass-heavy or muffled, while 

the bandpass output sounds thin and weedy. 

The filter also resonates, which means that frequencies close to the 

cutoff frequency can be greatly accentuated.  The VCF peak 

parameter controls this phenomenon.  Sweeping the cutoff 

frequency up or down with time gives that classic squelching filter 

sound.  Octavius Squeezer provides many and varied ways to sweep 

the filter up and down. 

The VCF mode parameter sets the basic operating mode of the filter.  

The simplest setting is stat, in which the filter does not move and the 

cutoff frequency is purely determined by the VCF ini frq parameter.  

The other two modes are env and ADSR. 

In env mode, the VCF acts as an envelope filter, meaning that the 

louder you play, the more the filter sweeps. The VCF att spd and VCF 

dec spd parameters control the attack and decay response speeds 

respectively, and VCF sweep controls the sensitivity.  The VCF sens. 

parameter on the Settings menu also acts as a global sensitivity 
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adjustment, so that you don’t need to adjust the VCF sweep 

parameter of all your effects if you switch to a different instrument 

with a different output level.  The VCF ini frq and VCF att frq 

parameters between them control the starting frequency, the sweep 

direction and the sweep limit. 

In ADSR mode, the filter follows a generated envelope with attack, 

decay, sustain and release phases, similar to the VCA envelope 

shown in Figure 11-2.  VCF ini frq controls the initial filter frequency, 

which sweeps to VCF att frq during the attack phase and then decays 

to VCF sus frq.  When the input note is released, the VCF releases 

back to VCF ini frq.  VCF att spd, VCF dec spd and VCF rel spd control 

the attack, decay and release speeds respectively.  

VCF ini frq, VCF att frq and VCF sus frq can be set to arbitrary values.  

It is possible, for example, to attack downwards from an ini frq of 

150 to an att frq 100, decay back up to a sus frq of 200 and then 

release back down to the ini frq at 150. 

11.6 LFO 

The LFO (Low Frequency Oscillator) can also vary the cutoff 

frequency of the filter, sweeping it up and down periodically.  The 

LFO output is added to the VCF control voltage produced by the VCF 

mode. 

The LFO is a triangle wave oscillator that runs at relatively low 

frequencies, adjustable through the LFO rate parameter.  If the LFO 

mod parameter is set to on, the LFO is triggered only when 

footswitch mode is set to MOD and the left footswitch is pressed.  

Otherwise, the LFO is triggered whenever a note is detected on the 

input. 

When the LFO is triggered, the depth of oscillation changes gradually 

from LFO ini dth to LFO att dth, at a rate controlled by LFO att spd.  

The oscillation depth remains at LFO att dth until the LFO becomes 

untriggered.  At that time, the LFO depth gradually changes back 

from LFO att dth to LFO ini dth at a rate controlled by LFO rel spd. 

11.7 Beat-locked effects 

Octavius Squeezer can also sweep or step the VCF in time with the 

beat.  This is known as a beat-locked effect.  A beat-locked sweep or 

step is added to the VCF control voltage as an offset just as the LFO 

is. 

The beat rate parameter is used to choose the beat-locked sweep 

rate.  Several interesting beat stepping functions are possible, 

including staircase, random and step sequence, in which a sequence 
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of filter steps is spelled out in letters in the name of the effect.  Beat 

wave is used to set the sweep waveform or stepping function.  Beat 

depth determines whether the beat offset is upwards or downwards 

and how big it is.  Beat smooth can be used to limit how quickly the 

control voltage changes at steps. 

11.8 Mixing and Patching 

There are many different ways to combine clean input, synthesized 

tones, the filter and the fuzz circuit together to produce the Octavius 

Squeezer’s final output.  In this section we’ll cover some mixing and 

patching strategies for various classes of effects. 

11.8.1 Synthesizers 

To create a synthesizer sound, you typically run the VCO output 

through the VCF by setting the VCO->VCF parameter to on and 

setting the VCO gain to 0 dB.  The lowpass VCF output is then 

selected by setting the output src parameter to LPF.  In a typical 

synth-only sound, the premix dB and postmix dB parameters are set 

to mute. 

For synthesizer effects, you also need to set the VCA parameters, 

particularly VCA att lvl and VCA sus lvl. 

11.8.2 Octavers 

To create an octaver, set up just like a synthesizer sound, put also 

blend the original input signal with the filter output.  This is done by 

setting the postmix src to in and setting the blend level with postmix 

dB.  For synthy-sounding octave effects with sweeping filters, you 

could instead blend the input signal with the synthesized octave 

before the filter by setting premix src to in and setting premix dB. 

11.8.3 Filters 

For filter-only effects, where the clean input runs through the filter 

and then out of the output, set VCO->VCF to off and set premix src 

to in.  Set output src to LPF or BPF and choose the gain using output 

dB. 

11.8.4 Fuzz 

For fuzz-only effects, set the fuzz source to in and set postmix src to 

fuzz.  Turn VCO->VCF to off and set premix dB and output dB to 

mute. 

11.8.5 Fuzz-Filter 

To run your input signal through the fuzz and then through the filter, 

set fuzz source to in and premix src to fuzz.  Postmix dB should be 

set to mute, output src is typically set to LPF and the output gain is 

chosen with output dB.  VCO->VCF should be set to off and you’ll 

need to set fuzz drv dB. 
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11.8.6 Filter-Fuzz 

It’s also possible to run the input signal through the filter first and 

then through the fuzz.  To get the input signal into the filter, set 

premix src to in and set premix dB to an appropriate amount of gain.  

Use fuzz source to choose the LPF or BPF filter output and set the 

fuzz drv dB.  Set postmix dB to fuzz and use postmix dB to control 

the volume level.  Output dB should be set to mute. 

11.9 Effect Parameter Reference 

This section explains each effect parameter in detail.  For an 

explanation of selecting and editing parameters, see section 4.6 on 

page 20. 

11.9.1 Input mode 

Chooses the synthesizer waveform.  The choices, shown in Figure 

11-3, are: 

 squr - Square wave with adjustable duty cycle. 

 tria – Triangle wave. 

 trap – Trapezoidal (clipped triangle) wave. 

 saw – Sawtooth wave. 

11.9.2 Output mode 

This parameter is reserved for future expansion.  At the moment, 

there is only one available choice, filt. 

11.9.3 Output src 

Chooses which filter output is sent to the output mixer.  The choices 

are: 

 BPF – Bandpass filter output. 

 LPF – Lowpass filter output. 

11.9.4 Output dB 

Mutes or sets the output mix gain of the filter.  The choices are: 

 mute – Mutes the filter in the output mix. 

 -24 .. +34 – A gain, in decibels, between -24 dB (very soft) 

and +34 dB (very loud). 

11.9.5 Premix src 

Chooses which signal is mixed with the synth before the filter.  The 

choices are: 

 in – The input signal directly from the in socket. 

 fuzz – The output of the fuzz circuit. 

squr tria

trap saw

Figure 11-3: VCO waveforms. 
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11.9.6 Premix dB 

Mutes or sets the gain of the signal premixed with the synth before 

the filter.  The choices are: 

 mute – No signal is premixed with the synth before the filter. 

 -24 .. +34 – A gain, in decibels, between -24 dB (very soft) 

and +34 (very loud). 

11.9.7 Postmix src 

Chooses which signal is postmixed with the filter output.  The choices 

are: 

 in – The input signal directly from the in socket. 

 fuzz – The output of the fuzz circuit. 

11.9.8 Postmix dB 

Mutes or sets the gain of the signal postmixed with the filter output.  

The choices are: 

 mute – No signal is postmixed with the filter output. 

 -24 .. +34 – A gain, in decibels, between -24 dB (very soft) 

and +34 (very loud). 

11.9.9 VCF mode 

Chooses the sweep mode of the filter.  The choices are: 

 stat – Static. The filter cutoff is at a fixed frequency given by 

the VCF ini frq parameter. 

 env – Envelope follower.  The filter starts at VCF ini frq when 

no note is being played.  When you play a note, the filter 

sweeps towards VCF att frq by an amount proportional to 

the level of the input signal.   

 ADSR – Envelope generator.  The filter starts at VCF ini frq, 

attacks to VCF att frq when a note is played, decays to VCF 

sus frq and then releases back to VCF ini frq when the note 

stops. 

11.9.10 VCF law 

Chooses the shape of the curve that the filter follows when it 

sweeps.  The choices are: 

 lin – Linear.  Increasing VCF ini frq increases the filter cutoff 

frequency by a linearly proportional amount in Hz. 

 exp – Exponential.  Increasing VCF ini frq increases the filter 

cutoff frequency by a linearly proportional amount in 

semitones (an exponential amount in Hz).  This mode 

generally sounds chunkier and more musical, since the filter 

sweeps up and down the musical scale. 
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11.9.11 VCF peak 

A number in the range 0 .. 31 which sets the resonance of the filter.  

Low numbers sound smooth and subtle.  High numbers sound in-

your-face, “peaky” and possibly distorted. 

11.9.12 VCF ini frq 

VCF initial frequency.  A number in the range 0 .. 255 which 

determines the starting frequency of the filter sweep.  0 represents a 

very low frequency (around 20 Hz) and 255 represents a very high 

frequency (around 8 kHz). 

11.9.13 VCF att frq 

VCF attack frequency.  A number in the range 0 .. 255 which 

determines the frequency that the envelope generator attacks to 

when a note is played.  The parameter is interpreted differently 

depending on the VCF mode as follows: 

 In stat mode, this number is ignored. 

 In env mode, the number is a limit, and the filter cannot 

sweep any further away from VCF ini frq than VCF att frq.  If 

VCF att frq is higher than VCF ini frq, then the filter sweeps 

upwards when you play a note.  Otherwise the filter sweeps 

downwards on each note. 

 In ADSR mode, the envelope generator sweeps from VCF ini 

frq to VCF att frq at the start of each note before switching 

to the decay phase of the note. 

11.9.14 VCF sus frq 

VCF sustain frequency.  A number in the range 0 .. 255 which 

determines the VCF frequency in the sustain phase when the VCF 

mode is set to ADSR.  The sustain phase lasts from the end of the 

decay phase until the note stops. 

If the VCF mode is not set to ADSR, this parameter is ignored. 

11.9.15 VCF sweep 

Envelope filter sweep gain.  When the VCF mode is set to env, this 

number, which is between 0 and 127 determines how far the filter 

sweeps in response to your playing.  When you set this to a high 

value, you only have to play softly for the filter to sweep a long way.  

When set to a low value, you’ll have to play quite hard to sweep the 

filter by an appreciable amount. 

The VCF sens. parameter on the Settings menu also affects the 

sweep distance in env mode. It is a global adjustment for the level of 

your instrument so you don’t have to retune the VCF sweep 

parameter of all your effects if you switch instruments. 
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11.9.16 VCF att spd 

VCF attack speed.  A number in the range 0 .. 15, the exact meaning 

of which depends on the VCF mode: 

 In stat mode, this parameter is ignored. 

 In env mode, this time constant affects how quickly the 

envelope follower responds to increases in volume.  Set it to 

a high value to have the filter sweep very suddenly at the 

start of each node.  Set it to a low value to have the filter 

sweep slowly and smoothly. 

 In ADSR mode, this value is proportional to the length of the 

attack phase. 

11.9.17 VCF dec spd 

VCF decay speed.  A number in the range 0 .. 15, the exact meaning 

of which depends on the VCF mode: 

 In stat mode, this parameter is ignored. 

 In env mode, this time constant affects how quickly the 

envelope follower responds to decreases in volume level. 

 In ADSR mode, this value is proportional to the length of the 

decay phase. 

11.9.18 VCF rel spd 

VCF release speed.  A number in the range 0 .. 15 which is 

proportional to the length of the release phase when the VCF mode 

is set to ADSR.  In other modes, this parameter is ignored. 

11.9.19 LFO rate 

A number in the range 0 .. 127 controlling the oscillation rate of the 

LFO. 

11.9.20 LFO ini dth 

Initial LFO depth.  A number in the range 0 .. 15 controlling the target 

LFO amplitude when the LFO is untriggered. 

11.9.21 LFO att dth 

End LFO depth.  A number in the range 0 .. 15 controlling the target 

LFO amplitude when the LFO is triggered. 

11.9.22 LFO att spd 

LFO attack speed.  A number in the range 0 .. 15 controlling how fast 

the LFO depth changes from LFO ini dth to LFO att dth when the LFO 

gets triggered. 

11.9.23 LFO rel spd 

LFO decay speed.  A number in the range 0 .. 15 controlling how fast 

the LFO depth changes from LFO att dth back to LFO ini dth when 

the LFO ceases to be triggered. 
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11.9.24 LFO mod 

LFO mod trigger switch.  The choices are: 

 off – The LFO is triggered while any note is detected at the 

input. 

 on – The LFO is triggered by the mod switch.  To active the 

mod switch, set the footswitch mode to MOD and push the 

left footswitch. 

11.9.25 beat rate 

Beat-locked sweep/step rate.  Controls how fast the filter sweeps or 

steps in time with the beat.  The choices are: 

 note – The filter steps at the start of each new note that is 

detected. 

 1/16 – The filter sweeps or steps on each 16th node 

(semiquaver). 

 1/8 – The filter sweeps or steps on each 8th node (quaver). 

 1/4 - The filter sweeps or steps on each quarter node 

(crotchet). 

 1/2 – The filter sweeps or steps on each half note (minim). 

 1bar – The filter sweeps or steps once per bar.  The number 

of beats per bar is set using the Beats per bar parameter on 

the Rhythm menu. 

 2bar – The filter sweeps or steps once every two bars. 

 loop – The filter sweeps or steps once over the whole loop.  

The loop length is set using the Bars in loop parameter on 

the Rhythm menu. 

11.9.26 beat wave 

Beat-locked filter sweep/step waveform selection.  The choices are: 

 cons – No sweep or step. 

 tria – Triangle wave with period set by beat rate. 

 ramp – Ramp (sawtooth) wave with period set by beat rate. 

 squr – Square wave with period set by beat rate. 

 sta4 – 4 step staircase.  Ascending steps are generated at the 

rate set by beat rate. 

 sta8 – 8 step staircase.  Ascending steps are generated at the 

rate set by beat rate. 

 rand – Random steps are generated at the rate set by beat 

rate. 

 name – Step sequence in effect name as described below. 

When name is selected for beat wave Octavius Squeezer finds the 

last sequence of uppercase letters in the name of the effect and uses 

it as a repeating step sequence.  Letter A means no filter offset (0%).  
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Letter Z means maximum filter offset (100%).  The sequence can be 

up to 16 letters long and is repeated indefinitely, resetting each time 

the start of the loop rolls around. 

For example, in an effect named Gobstopper ANZN, ANZN would be 

interpreted as the repeating step sequence 0%, 50%, 100%, 50%. 

11.9.27 beat depth 

Depth control for beat-locked filter sweeping and stepping.  This is a 

number in the range -127 .. +127.  When set to a negative number 

the filter sweeps or steps downwards with the beat.  For positive 

numbers, the filter sweeps upwards. 

11.9.28 beat smooth 

Slew rate limiting control for beat-locked stepping.  When the filter 

steps suddenly from one frequency to another, a slight click may be 

heard.  You can use this control to limit the speed, known as the slew 

rate, when stepping from one frequency to another.  This is a 

number in the range 0 .. 15.  

11.9.29 fuzz source 

Chooses the input signal for the fuzz circuit.  The options are: 

 in – The input signal directly from the in socket. 

 BPF – The bandpass output of the filter. 

 LPF – The lowpass output of the filter. 

 syn – The synth output. 

11.9.30 fuzz drv dB 

The gain applied at the input to the fuzz circuit, which controls how 

hard the fuzz circuit is driven.  The choices are: 

 mute – The fuzz circuit is driven with silence. 

 -24 .. +34 – Gain, in decibels, applied at fuzz input. 

11.9.31 gate mode 

Chooses the method used for gating the fuzz circuit.  The choices are: 

 off – No gating. 

 note – Fuzz is only active when a note is detected. 

11.9.32 VCO->VCF 

Chooses whether the VCO sends output to the filter premixer.  The 

options are: 

 off – The VCO output is disconnected from the filter 

premixer.  You can use the premix src parameter to drive 

another signal into the filter instead. 

 on – The VCO is connected to the filter premixer. 



57 Modifying Effects 
 

Octavius Squeezer user manual 
 

11.9.33 VCO pitch 

Chooses the pitch of the synthesized tone relative to the input note.  

The options are: 

 same – Same pitch as the input. 

 -1oc – One octave below the input. 

 -2oc – Two octaves below the input. 

 +1oc – One octave above the input. 

 +2oc – Two octaves above the input. 

 +5th – A perfect fifth (7 semitones) above the input. 

11.9.34 VCO duty 

When the input mode is set to squr, the duty cycle of the waveform 

is selectable using this parameter.  In other input modes this 

parameter is ignored. 

The duty cycle is the percentage of the period that the waveform 

spends in the high state.  So, when the duty cycle is 50% the 

waveform is symmetrical, spending an equal percentage of the time 

high and low.  This sounds “fat” and “square” and accentuates the 

fundamental frequency of the sound.  When the duty cycle is 6%, the 

waveforms spends 94% of its time low and only briefly pulses high at 

the start of each period.  This sounds thinner but has a more complex 

harmonic character which sounds great when filtered.  Figure 11-4 

shows how the waveform changes when you adjust the duty cycle. 

The options are: 

 50% - 1/2 duty cycle 

 25% - 1/4 duty cycle 

 12% - 1/8 duty cycle 

 6% - 1/16 duty cycle 

11.9.35 VCO dB 

Sets the overall volume level of the synthesized tone by setting the 

output gain of the VCO.  The options are: 

 mute – The VCO is muted. 

 -24 .. 0 – The gain, in decibels, applied to the VCO. 

11.9.36 VCO stop 

Sets the behaviour of the VCO when the input note stops.  The 

options are: 

 off – The VCO does not stop running when the input note 

stops.  This allows the VCA to slowly attenutate it, producing 

a smooth release. 

50% 25%

Figure 11-4: Square wave with 
50% and 25% duty cycle. 
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 on – The VCO abruptly stops oscillating as soon as the input 

note stops.  This makes for very precise, clipped notes. 

11.9.37 VCO att pto 

Sets the amount of portamento applied during the attack phase of a 

note.  It is a number in the range 0 .. 15.  0 means no portamento.  

15 means slow gliding portamento. 

11.9.38 VCO sus pto 

Sets the amount of portamento applied during the sustain phase of a 

note.  It is a number in the range 0 .. 15.  0 means no portamento.  

15 means slow gliding portamento. 

11.9.39 VCA mode 

Chooses the operating mode of the Voltage Controlled Amplifier, 

which determines the amplitude envelope of the synthesized tone.  

The options are: 

 ADSR – Envelope generator mode.  An amplitude envelope is 

synthesized with attack, decay, sustain and release phases. 

 env – Envelope follower mode.  The amplitude of the 

synthesized tone tracks that of the input signal. 

11.9.40 VCA att spd 

VCA attack speed.  A number in the range 0 .. 15, the exact meaning 

of which depends on the current VCA mode.  In ADSR mode, VCA att 

spd controls how quickly the attack phase completes.  In env mode, 

VCA att spd controls how quickly the envelope follower responds to 

increases in input volume. 

11.9.41 VCA dec spd 

VCA decay speed.  A number in the range 0 .. 15, the exact meaning 

of which depends on the current VCA mode.  In ADSR mode, VCA 

dec spd controls how quickly the decay phase completes.  In env 

mode, VCA dec spd controls how quickly the envelope follower 

responds to decreases in input volume. 

11.9.42 VCA rel spd 

VCA release speed.  A number in the range 0 .. 15 which controls 

how quickly the release phase of the envelope completes.  This 

parameter is only relevant when the VCA mode is set to ADSR and is 

ignored otherwise.  Also note that the VCO stop parameter must be 

set to off in order for VCA rel spd to have any audible effect. 

11.9.43 VCA att lvl 

VCA attack level.  A number in the range 0 .. 63 which controls the 

volume level that the VCA attacks to when the VCA mode is set to 

ADSR. 
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11.9.44 VCA sus lvl 

VCA sustain level.  A number in the range 0 .. 63 which controls the 

volume level that the VCA produces during the sustain phase. 

11.9.45 VCA reatt. 

VCA re-attack switch.  Determines whether the VCA switches back to 

attack phase when a new note is detected while the synthesizer is 

playing a note.  The options are: 

 off – If a new note is detected the ADSR phase is unaffected.  

This allows you to play long sustained passages with one 

note blending into the next. 

 on – If a new note is detected the ADSR switches 

immediately back to attack phase.  This means that notes 

played in quick succession will be heard as distinct 

synthesized notes. 

11.9.46 protect 

Write protection switch.  Prevents modification of this effect in the 

library when set to on. 
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